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Scope
• This document is a joint design and implementation reference guide for Aruba and Ekahau RTLS
deployments
• This document specifies high‐level requirements and design considerations for successful deployment
of the joint solution
• For an online introduction to Ekahau deployments for RTLS, see this link1
• This document covers the more common Tag Association Mode as well as the unique Aruba Blink
Mode implementations
• This document covers Ekahau Activator usage
• This document assumes a base level of Aruba WLAN product and design knowledge. For details
involving configuration of Aruba OS, please see the ArubaOS User Guide for the version of software in
your environment, located on the Aruba Support site at http://support.arubanetworks.com

Solution Overview
Enterprises lose millions of dollars a year because critical equipment is misplaced, stolen or not
maintained properly. Asset tracking with Real Time Location Systems (RTLS) over Wi‐Fi allows
continuous tracking of valuable equipment or people over the WLAN. The ability to instantly locate a
critical device can reduce not only replacement costs for lost equipment, but also enable far more
efficient use of existing inventory. The result is reduced costs as well as improvements in workflow,
security and customer service.
The Ekahau RTLS solution leverages existing 802.11 networks to provide accurate, real‐time location
tracking of ‘tagged’ assets. An Ekahau asset tag is a small Wi‐Fi enabled device that can be attached to a
critical asset, or worn as a personnel badge. The tag then uses the existing wireless LAN to communicate
with an Ekahau Positioning Engine server. The EPE uses signal strength values, received either from the
tag or the Aruba infrastructure to calculate and continuously track the tag’s location. Software versions
of tags also exist for Wi‐Fi enabled devices such as laptops or handhelds. Solution components include
Ekahau’s Positioning Engine server, the Ekahau Site Survey, and the Ekahau application layer, consisting
of Ekahau Tracker or Ekahau Vision.
The Aruba User–Centric Network provides Ekahau RTLS users with two major advantages over other
WLAN infrastructure vendors: superior security and tighter integration.
• Superior Security: Aruba controller’s security model allows a user role to be specifically assigned to
Ekahau traffic. This enables appropriate isolation and prioritization of tag‐to‐server communications
from other network traffic, offering optimized communication, and maximizing security of even older
WEP‐only tags.
• Tighter Integration: Aruba’s integration with Ekahau RTLS enables asset tags to operate in “Aruba
Blink Mode.” Aruba Blink Mode reduces the amount of time an asset tag spends transmitting radio
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signals and results in a 5x extension of tag battery life. In a hospital environment tracking thousands
of devices, the reduction in overhead of managing tags is substantial.

About the Ekahau RTLS Solution
The Ekahau RTLS solution consists primarily of the Ekahau Positioning Engine (EPE) server, battery
powered Wi‐Fi tags and a laptop based planning and calibration tool, Ekahau Site Survey (ESS). There
are also supporting applications and an open API for HTTP and XML access to the positioning engine data.
The Ekahau RTLS installer file includes all the components of Ekahau RTLS, out of which the user can
select the appropriate components. The Ekahau Application Layer, Ekahau Vision, is installed separately.

Ekahau Positioning Engine (EPE)
EPE is the centerpiece of Ekahau RTLS. It runs on Windows XP or Windows 2003 Server. The EPE
manages and configures asset tags through the wireless network, calculates locations from Wi‐Fi signal
strength measurements, and provides event handling and two way tag communication.

Ekahau Site Survey (ESS)
Ekahau Site Survey is a planning / site survey / troubleshooting tool for Wi‐Fi. It runs on a Windows
laptop, and uses an Atheros‐based 802.11a/b/g/n Wi‐Fi adapter for site survey measurements.
ESS is also a tool for creating and calibrating a Positioning Model (or a Project) to enable accurate location
tracking. A positioning model is a software representation of a building and its RF environment. ESS is
used to import site maps, perform site surveys, and perform RTLS related operations such as drawing
tracking rails and zones.
For details, see www.ekahau.com/ess.

Ekahau Wi-Fi Asset Tags
There are several models of battery powered Wi‐Fi tags available for Ekahau RTLS. The two most
common are the T301a and the T301b.
The T301a asset tag has a multi‐year battery and a motion sensor and is typically used for devices such as
IV pumps, crash carts, etc.
The T301b is a rechargeable credit card sized badge for personnel tracking. It has a pull switch that
serves as an emergency alarm, call buttons, and an option for sending and receiving text messages.
There are also specialized tags, such as a temperature sensor equipped model, Ex certified intrinsically
safe tag, industrial tag, and software based “tags” for Wi‐Fi enabled devices such as laptops, PDAs,
barcodes scanners, etc.

Ekahau Vision and Third-Party Software Integration
Whereas the Ekahau Positioning Engine is used to manage the system and tag configurations, a separate
application is useful for providing value‐added services leveraging the location information provided.
Ekahau Vision is an enterprise asset‐ and people‐tracking application that allows the user to search and
find assets, raise and acknowledge alarms, monitor temperature levels, and send and receive messages
from T301B tags.
Ekahau also provides an open API for third‐party application development. The complete API with
descriptions is included in the Ekahau RTLS installer package.
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Ekahau Tag Activator
Ekahau Activator is used for activating Ekahau T301 series tags. Activating gives the initial configuration
(SSID, encryption, etc.) for the tags, so that the tags can connect to the network and thus to the Ekahau
Positioning Engine, where the tags can be configured for production use.

Aruba and Ekahau RTLS Design Considerations
Security
The Aruba user‐centric network establishes the highest‐possible security for an Ekahau RTLS
deployment as part of its normal operation.
Ekahau T301 series tags support WPA2‐PSK AES encryption (TKIP/AES mixed mode is not supported)
and WEP encryption. Older Ekahau T201 tags support 64‐ and 128‐bit WEP.
Ekahau recommends for additional security that a firewall be used between the RTLS SSID/VLAN and the
rest of the network. The Aruba Controller’s Policy Enforcement Firewall and ICSA certified stateful
firewall resident on the controller is ideal for this purpose.
A user role should be created specifically for the Ekahau tags allowing only Ekahau traffic between the
tags and the Ekahau Positioning Engine server. No other traffic should be allowed from the tags to the
rest of the network.

Tag Operation Modes: Aruba Blink Mode and Association Mode
The Ekahau RTLS system can be based on signal strength measurements taken at the tags (Association
Mode) or, when using Aruba infrastructure, the measurements can be taken at the APs (Aruba Blink
Mode).

Tag Association Mode
In association mode, the tag simply acts as a Wi‐Fi client on the network. It associates to an AP for all
communications with the Positioning Engine server. The tag, as a client, measures the signal strengths
from the nearby APs and reports the results to the Positioning Engine server over the WLAN.
Figure 1

Location Tracking in Association Mode
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The advantage of this mode is it works with any WLAN. The disadvantage is that the accuracy may
slightly suffer from dramatic changes to the AP infrastructure, such as several APs making drastic
changes to the transmission power (1mW to 50mW for example). However, based on live testing, 2‐4x Tx
power changes on an AP have no noticeable impact to the Ekahau RTLS location accuracy, and ARM
power changes can be limited to a predefined minimum and maximum range.
When using Association Mode to track Ekahau T301 tags, the recommended practice is to calibrate
(survey) the network with Ekahau Site Survey and a T301 tag operating in Survey Mode. Prior to
calibrating, the tag needs to be activated to Site Survey Mode using Ekahau Activator. An Atheros‐based
network adapter, such as the Ekahau NIC‐300, is required for this, see www.ekahau.com/devices.
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Figure 2

Site Surveys in Tag Association Mode

Aruba Blink Mode
In Aruba Blink mode, the tag sends beacon signals at set intervals to a predefined set of channels. Aruba
APs measure and report the signal strength of the beaconing tags and the signal strength information gets
forwarded to the Ekahau Positioning Engine.
Figure 3

Location Tracking in Aruba Blink Mode

This approach has several advantages:
• ARM adjustments have no impact on location accuracy – tags beacon at a set power and on set
channels, so changes in AP behavior do not affect RTLS accuracy. ARM maximizes the efficiency of the
WLAN, so the user gets best of both worlds – an adaptive and responsive RF environment and
accurate RTLS.
• Battery life and TCO – in beacon mode, tags extend their battery life by a factor of 5x. In a hospital
tracking thousands of devices, the reduction in overhead to update or replace or recharge tags could
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be tremendous. Note that the longevity of a tag’s battery depends on configurable factors – how often
to beacon, etc. – but in beacon modes it would be typical for a tag battery to last for years.
When calibrating the RTLS for operation in Aruba Blink Mode, the recommended practice is to utilize
Ekahau Site Survey with a T301a tag operating in Aruba Blink Mode. In this mode, the APs will measure
the tag signal strength during the survey, and the data will be forwarded from the Aruba controller to the
Ekahau Positioning Engine, and then back to Ekahau Site Survey via the Aruba WLAN.
Figure 4

Site Surveys in Aruba Blink Mode

Please note that for Ekahau tags operating in Aruba Blink Mode, there is no need to associate to the
network to perform location updates. Tags can still, however, be configured to perform maintenance
sessions in association mode in order to communicate to the EPE server for firmware updates,
configuration changes, and to receive custom commands. Location‐update intervals are configured
independently of maintenance intervals (two‐way sessions) in the Ekahau Positioning Engine.

Design Recommendations
There are a number of important planning decisions that should be considered for a proper RTLS
deployment. This document is concerned with the details of the Aruba WLAN portion of a full Ekahau
deployment. It is recommended that Ekahau documentation and resources also be referenced and
utilized for optimum results. In particular, the document “Ekahau RTLS Guide” from Ekahau Professional
Services is highly recommended for this purpose.

Aruba & Ekahau RTLS Deployment Steps
1. Deploy an Optimized Aruba WLAN Infrastructure: Ensure WLAN quality is sufficient for accurate
RTLS, ‘Voice capable’ if possible, and ensuring smooth roaming throughout the tracking area for the
tag
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2. Create the WLAN for RTLS: Provide sufficient IP space in a single subnet for all tags, dedicate an SSID
that supports 802.11b clients with 1 Mbps and 2 Mbps rates, and configure the firewall rules and user
profiles for tags
3. Deploy Ekahau Positioning Engine (EPE): Install the EPE on the network, if in Aruba Blink Mode,
configure Aruba controller(s) to feed data to the Ekahau server and configure the EPE to accept this
data stream from the Aruba controller(s)
4. Activate Survey Tags and Perform Ekahau Site Survey: One tag must be configured for rapid
blinking to perform quick site surveys2
The site survey process is done using a laptop computer and a wireless network adapter. The surveyor
walks throughout the tracking area with the laptop, frequently clicking on the current location on the
map.
Whether in Aruba Blink Mode or Tag Association Mode, an Ekahau T301a tag must be properly
configured and carried by the surveyor when performing the site survey.
• In Aruba Blink Mode, the readings will come in to Ekahau Site Survey from Positioning Engine (a Wi‐Fi
connection must be maintained)
• In Tag Association Mode, the tag will send the readings to the local network adapter (needs to be
Atheros based, see www.ekahau.com/devices), and the adapter will forward the readings to Ekahau
Site Survey
After the site survey, Rails and Open Spaces are drawn to indicate typical paths of movement, and
optionally define Zones for advanced application layer functionality.
5. Draw Tracking Rails, Open Spaces, and Zones
6. Upload Positioning Model from Ekahau Site Survey to Ekahau Positioning Engine
7. Deploy Tracking Tags: Use the Ekahau Activator to connect the tags to the network and to the EPE,
also use the EPE Web UI to configure the desired tag parameters such as wakeup interval, motion
on/off, Aruba Blink Mode vs. Association Mode, etc.

Step 1: Deploy an Optimized Aruba WLAN Infrastructure
For those with experience deploying Aruba products, Ekahau’s simplest recommendation for WLAN
design best practices for RTLS is that the WLAN should be “voice‐capable”. Accurate location
requirements are more stringent than for basic data coverage. RF signal strength (RSSI), number of
audible access points per location, and access‐point proximity are factors that will affect the accuracy of
the RTLS system.
Signal Strength and Number of APs
For reliable data transmission, the tag needs to hear at least one AP at ‐70dBm to be able to communicate
with the network reliably. For high reliability we recommend “Voice Grade” coverage at ‐65 dBm
minimum.
Coverage requirements for good location accuracy contend that the tag will always be capable of
detecting at least three access points. At least one of those APs should be heard at ‐62 dBm or higher. The
additional APs should be heard at ‐75 dBm. Location accuracy is expected to be better in close proximity
to a strong access point. If at least one AP is audible at ‐50dBm or higher, then high location accuracy is
still expected.
ARM  Dynamic Power Allocation

2 If in Aruba Blink Mode, activate the tag and configure for rapid blinking via
Engine. If in Association Mode, use Ekahau Activator to configure the tag to
Site Survey mode.
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Ekahau tags operating in Aruba Blink Mode are fully compatible with dynamic power adjustment. Tag
power remains consistent, so the transmission power of APs does not impact location accuracy in any
way. ARM also minimizes interference and automatically provides the most stable environment for tag
communication.
In Association Mode, ARM changes can have a small impact on location accuracy, which can be further
mitigated by setting minimum and maximum thresholds for ARM power adjustments.
In multi‐vendor environments involving other non‐Aruba WLAN infrastructure vendors, Association
Mode should be used since Aruba Blink Mode is not supported and thus will not work at the entire site.
The other vendor’s automatic channel and power adjustment algorithms (if applicable) can also impact
the location accuracy in the same way.
In either case where tag Association Mode is used, the Ekahau location algorithms are designed to
neutralize the ARM impact as much as possible.

Step 2: Create the WLAN for RTLS
IP Addressing
Tags require unique IP addresses on a single subnet. Two‐way communication will take place with the
server, allowing tags to receive programming changes over the air, and enabling messaging with the
T301 BD tag. A sufficient number of static or DHCP IP addresses must be allocated for the number of
tracked devices. Tags should not require a new IP address or default gateway until the DHCP lease time
has expired.
WLAN SSID
A dedicated RTLS SSID is recommended to support communications between RTLS Tracking Tags and
the Location Engine. The SSID assigned to the RTLS system must cover the entire tracking project area.
Data Rates
T301 data transmission is limited to 802.11b rates. 1 Mb and 2 Mb data rates should be configured as
“required.” Other data rates (5.5, 11, etc.) including those for 802.11g and 802.11n may be configured as
supported.
802.11 Security
Ekahau T201 tags currently support 128 bit WEP encryption. Ekahau T301 tags support WEP and WPA2‐
PSK. For WPA2‐PSK, encryption should be AES only (TKIP/AES mixed mode is not supported).
Tag User Roles
Tag traffic should be isolated from the rest of the network by the Aruba Policy Enforcement Firewall. A
user role should be created for the tags. This rule should allow the tags to communicate only with the
Ekahau Positioning Engine, and only over the correct protocols.
Client devices and applications initiate a session to the positioning engine via standard communication
ports (see Configuration section in this document for this list in Table 1).
Figure 5
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Common WLAN Deployment Architecture
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Step 3: Deploy Ekahau Positioning Engine (EPE)
At this point, the WLAN and network would be prepared for the Ekahau deployment.
Install Ekahau Positioning Engine
Consult Ekahau documentation or Ekahau, Inc. for detailed recommendations. The EPE runs on Windows
Server 2000, Windows Server 2003 or under VMWare. Hardware recommendations depend on the
number of Tag clients to be serviced.
Configure Aruba Controller(s) for EPE communication
If using Aruba Blink Mode, assign an RTLS server in an AP configuration profile in the Aruba Controller:
Configuration > Wireless > AP configuration > <AP group> > AP > AP system Profile > RTLS Server
Configuration
If Aruba Blink Mode is not used, you will not need to adjust RTLS server configuration in the Aruba
system.
Configure EPE to Accept Aruba Data
If using Aruba Blink Mode, you will have to add a shared key to a file in a text editor and restart the EPE
service.
If Aruba Blink Mode is not used, you will not need to adjust EPE server as the data will be coming in
directly from the tags, not the Aruba system.

Step 4: Activate Survey Tags and Perform Ekahau Site Survey
Prior to deploying an Aruba/Ekahau RTLS system a site survey of the entire project area must be
performed.
Prior to performing site surveys, you will need to activate the tag for a rapid blink rate. Please see later in
this document for details on activating tags for either Aruba Blink Mode or Survey mode to operate
Association Mode.
In Association Mode Site Survey, the RSSI values of APs are taken by the tags and directly sent to the site
survey laptop in relevant locations.
In Aruba Blink Mode Site Survey, the signal data sent by the tag operating in Aruba Blink Mode (with
frequent scanning, see Ekahau Site Survey documentation for set‐up instructions) will be measured by
the APs and sent via Positioning Engine to Site Survey.
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Step 5: Draw Tracking Rails, Open Spaces, and Zones
After the site survey, rails will be drawn along the survey paths using ESS to indicate the common paths
of movement of the tracked devices in a given environment. Open spaces represent areas where devices
will not follow pre‐defined pathways of movement. Leveraging rails and open spaces accurately increases
the location accuracy.
Finally, depending on the location‐based application, Zones may be drawn with Ekahau Site Survey.
Zones are areas on the map which have a defined purpose. For example, in some applications it may be
more intuitive to say “the doctor is in the cafeteria” than displaying a dot on the map.

Step 6: Upload Positioning Model from Ekahau Site Survey to Ekahau Positioning
Engine
After the work with Ekahau Site Survey is completed, save the Project (Positioning Model). It is
recommended to save the project during the survey work also, under different names, to prevent
accidental loss of data.
To start tracking, the project then needs to be uploaded to Ekahau Positioning Engine and activated.
Ekahau recommends manually copying the .esx Project file from the Site Survey laptop to Engine server,
and then uploading the .esx Project file (Positioning Model) manually to Ekahau Positioning Engine using
Ekahau Positioning Engine Web GUI. When uploading the Model, activate it to start tracking.
You can also save the Positioning Model directly from ESS to EPE (in ESS, select File > Save to Engine), but
for this, a wired Ethernet connection is recommended.
Figure 6

Saving to the EPE Directly from ESS

Step 7: Deploy Tracking Tags
To deploy Ekahau tags for tracking, they must first be activated to connect to the WLAN and contact the
Ekahau Positioning Engine server. This is done with Ekahau Activator.
Once tags have made a connection to EPE, configure them in the EPE via the Configs page and deploy
them to critical assets as appropriate. Please note that the less frequently the tags blink, the longer the
battery life will be. EPE Web GUI includes a battery life estimator to see how long the tags will last with
the configured settings.
Different settings can be used for different use cases. For example, staff tracking may require 30 second
updates, whereas waking up once every 30 minutes may be enough for asset tracking purposes.

10
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If using Aruba Blink Mode, the appropriate tag configuration must be applied (check the Aruba Blink
Mode checkbox in the EPE GUI).

Aruba and Ekahau Configuration for RTLS
Configuring the System
This document is concerned with the specific details of integrating Aruba and Ekahau systems. There is
ample documentation specific to each system, and this document assumes that more detailed
documentation is available from each vendor.
This section delves into further detail for each of the recommended design best practices steps.

Configuring Step 1: Deploy an Optimized Aruba WLAN Infrastructure
Please refer to the Aruba Configuration Guide and related Aruba documentation. The Aruba WLAN
should be built out with the following needs in mind:
Voice Capable
Plan the WLAN under the same guidelines as for a voice‐capable system
Signal Strength and Number of APs
Areas requiring “excellent” location coverage:
• Tags should be detectible by at least three access points.
• At least one of those APs should hear the tag at ‐62 dBm or higher. The other two APs should receive
at least ‐75 dBm.
• You can achieve a high accuracy with just one AP being audible, as long as it is audible at ‐50dBm or
better – the accuracy is typically good close to an AP
Areas requiring minimal location coverage
• A minimum signal of ‐75dBm (is always required. ‐65 dBm minimum coverage or better is
recommended for higher reliability.
Ekahau Site Survey has the Location Coverage visualization to display how good the location coverage is.
Use “Location Coverage for My Access Points”.
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Figure 7

Location Coverage Visualization in ESS

ARM, Channel and Power Assignments
Ekahau tags are fully compatible with ARM when in beaconing mode. ARM is always recommended and
has no impact on location accuracy. In tag Association Mode, there may be some impact on location
accuracy. To limit this, set the maximum power adjustment threshold in ARM to a lower value.

Configuring Step 2: Create the WLAN for RTLS
The following steps are required in ArubaOS to create the WLAN used for location tracking:
• IP address space sufficient for all tags, in a single subnet
• Firewall rules and user role for tags
• Dedicated SSID for Tag use
• 802.11b with required rates of 1MB and 2 MB
• Channel assignment (as required for enterprise WLAN coverage)
IP Addresses
Tags require unique IP addresses on a single subnet. Two‐way communication will take place with the
server, allowing tags to receive programming changes over the air, and enabling messaging with the
T301 BD tag. A sufficient number of static or DHCP IP addresses must be allocated for the number of
tracked devices. Tags should not require a new IP address or default gateway until the DHCP lease time
has expired.
How this is structured will depend on the architecture of the network. One possibility is to have a
dedicated wireless VLAN for only tag‐related traffic. This VLAN could then route to the location of the
Ekahau Positioning Engine. To add a VLAN to the controller for RTLS tag, see next section on configuring
VLANs.
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Configuring the VLANs
Navigate to Configuration > Network > VLANs page and select the VLAN link. This page will display all the
VLANs configured so far. To create a new VLAN, click on the Add tab and configure the VLAN. After
entering the configuration information, click the Apply tab to apply the settings. This will create a new
VLAN.
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Figure 8

ArubaOS, Configuring a VLAN

Navigate to Configuration > Network >IP page and select the IP link. This page will display all the VLANs
along with their IP Interfaces that have been configured so far. To configure an IP interface for the VLAN,
Click on the Edit button along the newly created VLAN and provision the IP address and the Net Mask.
Figure 9

ArubaOS, Configuring an IP Interface for the VLAN

Assigning ports to a VLAN
You have the option of assigning a physical port to the RTLS VLAN. However, the VLAN does not have to
have a physical port assignment. The wireless traffic can be contained on a wireless only VLAN and then
routed to a wired VLAN. The final design will depend on the network.
If you wish to assign a physical port to the RTLS VLAN:
Navigate to the Configuration > Network > Port page. Select the port that needs to be configured and set
up as required. In this example, the port connecting to the L2 switch is a trunk port with other VLANs
(data and voice for example). For configuration guidelines, refer to the ArubaOS User Guide.
Figure 10
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ArubaOS, Assigning a Port to the RTLS VLAN
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Firewall Rules and User Role for Ekahau Tags
Ekahau tags may not use the same encryption as other devices on the network. Ideally, they should be
restricted by the Aruba Policy Enforcement Firewall for maximum security. The standard ports for
Ekahau traffic are listed below. Note that most of these ports are configurable, and that you may not use
all tag models in your environment. The EPE server (for firewall purposes) does not initiate
communication with the tags, but responds to the tag, so the firewall rules only need to be unidirectional
to account for this flow of traffic.
Client devices and application initiate a session to the positioning engine via the communication ports as
described in the table below.
Table 1

Ekahau Communication Protocols and Ports

Protocol/Port

Service

TCP/8550

Ekahau EPS GUI and T201 tag maintenance

TCP/8548

Ekahau T201 tags

UDP/8549

Ekahau T201 tags

UDP/8554

Ekahau T301 tags firmware update

UDP/8552

Ekahau T301 tags

UDP/8553

Ekahau T301 tags

UDP/8545

Ekahau clients (software tags) location update

UDP/8546

Ekahau clients (software tags) location update

TCP/8560

Ekahau Vision Application

To configure these access policies, navigate to the Configuration > Security > Access Control > Policies page.
Click on Add to add a new firewall policy and configure it similarly to as shown.
Figure 11

ArubaOS, Configuring Access Control Policies
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The policy as configured in the above example allows all tag models. The Ekahau server is assigned an
alias to simplify changes if the server’s IP address changes. Likewise, the tag network could be assigned
an alias or defined more precisely, rather than using ‘any’ as the source in the rule definition.
A Note on Blacklisting
A rouge data device could attempt to spoof a RTLS client (tag) in order to gain network access. In order to
prevent this, policy violators can be blacklisted. For example, a user on the Ekahau tag role that tries to
access the non‐RTLS servers or infrastructure or use non‐Ekahau protocols or non‐Ekahau ports can be
blacklisted and denied any access to the network.
To configure blacklisting, navigate to the policy configuration page Configuration > Firewall Policies > Edit
Policy (EkahauTags) and add the rule: ‘any any any deny blacklist’. Note that this must be the last rule in
the ACL list.
To take action on the blacklisted clients and prevent them from accessing the network, go to
Configuration > RF Management > Protection and enable DoS Protection. This will result in the client
being de‐authed if they try to access the network.
Assign Policies to the Role
Once the policies are created they need to be assigned to the user roles that the devices will be assigned
to upon successful authentication. The role defined in this example is ‘EkahauTags’. Navigate to
Configuration > Security > Access Control > User Roles, and then click Add. Name the role, then add the
firewall policy created above. Once complete, then Apply and Save Configuration.
Figure 12
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ArubaOS, Adding User Roles
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Dedicated SSID - WLAN Configuration
Configuring the WLAN settings involves the following steps
• Configuring an AP group which is the logical collection of APs with the same RF and Security settings
• Assigning the virtual APs and authentication profiles to the APs
• Assigning the right AP groups to the APs that connect to the controller
Refer to the ArubaOS User Guide for initial configuration of the APs. Once the APs are connected, they will
bootstrap to the controller and will be assigned the default profile. After this, the APs can be seen on the
controller as “Aruba Access Points” on the Monitoring > Network Summary page.
In ArubaOS, related configuration parameters are grouped into profiles that can be applied as needed to
an AP group or to individual APs. You can apply the following types of profiles to an AP or AP group:
Wireless LAN Profiles configure WLANs in the form of Virtual AP Profiles. A Virtual AP profile contains an
SSID Profile which defines the WLAN and an AAA Profile which defines the authentication for the WLAN.
This is the profile we are concerned with for the purposes of Ekahau integration.
Other profiles available:
• AP Profiles configure AP operation parameters, radio settings, port operations, regulatory domain, and
SNMP information
• QoS Profiles configure traffic management and VoIP functions
• RF Management Profiles configure radio tuning and calibration, AP load balancing, coverage hole
detection, and RSSI metrics
• IDS Profiles, Wireless Mesh Profiles, etc. for more advanced configurations for WIPS and mesh
deployments
AP Groups, AAA Profile, Virtual AP Profile, SSID Profile Configurations
Ekahau RTLS will be increasingly accurate as the density of deployed APs in the desired area for location
tracking increases. Depending on how the APs are deployed and managed in the network, you may want
to add the WLAN profile for the Ekahau SSID to most or all of your AP groups.
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Navigate to Configuration > Wireless> AP Configuration > AP Group
Figure 13

ArubaOS, Adding AP Groups

Click on the New button to create a new group, or click on Edit to add the Ekahau WLAN profile to an
existing group. Navigate to Wireless LAN and to Virtual AP. The full path is:
Configuration > Wireless> AP Configuration > AP Group > [AP group name] > Wireless LAN > Virtual AP
From the drop down, choose New, and then provide the profile a name (Ex. ‘EkahauRTLS’) and click Add.
Note that if the Ekahau RTLS WLAN profile has already been created, it could be added to a Virtual AP
profile from here. To finish the configuration:
• From the AAA drop down, choose “default‐dot1x‐psk” – click Apply in the resulting screen. Alternately,
choose New from the drop down and create a specific AAA profile.
• From the SSID Profile drop down, choose New. In the resulting screen:


Give the profile a name – Ex. “EkahauRTLS”



Type an SSID for the profile - Ex. “ekahau”



Choose the radio button for “WPA2-PSK” (this is assuming T301 badges; choose WEP
or open if otherwise required based on badge capabilities)



Choose AES encryption (default)



Under “Keys” choose Hex or passphrase and type the PSK (Pre Shared Key) you have
chosen for this WLAN



Click Apply



In the resulting screen (the virtual AP list) click Apply and then
Save Configuration

• Confirm SSID minimum data rates are supported


In the profile tree, go to the new profile, ‘SSID profile’ and then click Advanced in the right hand
window. The full path is:
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Configuration > Wireless> AP Configuration > AP Group >[ AP group
name] > Wireless LAN > Virtual AP > [Ekahau SSID profile] > SSID
profile > Advanced

[Aruba & Ekahau Design & Implementation Guide] | 01.22.09



Confirm that 1 Mbps and 2 Mbps data rates are supported on the g (2.4 GHz)
band

Figure 14

ArubaOS, AP Configuration, SSID Profile (Basic)
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Figure 15

ArubaOS, AP Configuration, Virtual AP Profile

Channel Assignment and ARM
As stated earlier, Ekahau tags operating in Aruba Blink Mode are fully compatible with dynamic power
adjustment. Tag power remains consistent, so the transmission power of APs does not impact location
accuracy in any way. ARM also minimizes interference and automatically provides the most stable
environment for tag communication.
In Association Mode, ARM changes can have a small impact on location accuracy, which can be further
mitigated by setting minimum and maximum thresholds for ARM power adjustments.
One must ensure that the channels used for ARM are the same as those the tags are configured to use. In
short, no major changes to ARM are necessary.
Configuring ArubaOS to Pass Data to the EPE
This step is only necessary for Aruba Blink Mode configuration, and is described in the next section.

Configuring Step 3: Deploy Ekahau Positioning Engine (EPE)
At this point, a WLAN that supports Ekahau tags has been configured. It is now necessary to complete the
Ekahau configuration. As a first step, an Ekahau Positioning Engine server must be added to the network.
Please see the Ekahau documentation for details, particularly:
• Ekahau Positioning Engine User Guide
• Ekahau RTLS Guide
Ekahau System Requirements
To set up infrastructure based positioning with Aruba, you will need, at a minimum:
• Ekahau Positioning Engine v.4.5 or newer
• Ekahau Site Survey 4.5 or newer
• Ekahau Activator 4.5 or newer
• Ekahau T301A tag FW version 2.3.43‐3
• Ekahau Atheros Wi‐Fi Adapter driver which is bundled with Ekahau Activator and ESS

20
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Note: Activator and must be installed from the same RTLS package, otherwise there may be a

driver mismatch if run on the same laptop
NOTE

• Ekahau T301 tags
• Laptop computer running Windows Vista or XP


This will run Ekahau Site Survey and Ekahau Activator

• Atheros‐based 802.11abg adapter for the laptop computer (see www.ekahau.com/devices for
supported adapters)
• Desktop computer running XP or Windows 2003 Server


Ekahau Positioning Engine will run on this computer

Install Ekahau Software

• Install Ekahau Positioning Engine on a Windows XP or Windows Server system
• Deploy that system on the network. The IP address of the EPE should match the alias used in the
Aruba Firewall Polices. Otherwise, the IP address of the firewall policy will have to be changed.


There will be an option to change the configuration of TCP/UDP ports used by the Ekahau system.
Changes here will mean changes or modifications of the firewall policy.

• Install Ekahau Site Survey and Ekahau Activator on the laptop. Also install the wireless network
adapter drivers for your Atheros‐based wireless network adapter. The installer recommends a driver
update, and updates the drivers if necessary.


This is in anticipation of the necessary site survey and creation of a positioning model

Configure the Aruba Controller to pass data to the Ekahau Positioning Engine
This step is only needed when using Aruba Blink Mode.
• Log into the Aruba Controller
• In the Aruba Controller Web Interface, navigate to:


Configuration > Wireless > AP Configuration > AP > AP System Profile



Scroll down to RTLS Server Configuration
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Figure 16

ArubaOS, AP System Profile, RTLS Server Configuration

In the RTLS server configuration, set Ekahau Positioning Engine IP, port, and enter an identification key
(you will need to enter this twice). The identification key is a shared secret that you can freely choose.
EPE uses the key to authorize the Aruba system to feed the signal data into the EPE.
Configure Ekahau Positioning Engine to Accept Data from the Aruba System
This step is only needed when using Aruba Blink Mode.
• Go to the EPE server
• Stop the EPE service
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Start > run > services.msc



Scroll to “Ekahau Positioning Engine Service” and double click



Click ‘stop’ – leave the window open
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Figure 17

EPE Configuration, EPE Services

• In the folder you installed the Ekahau software, open the file conf/system.properties in a text editor


Default path: C:\Program Files\Ekahau\Ekahau Positioning Engine\conf\system.properties



Type the following line in the system.properties file:



•

apreceiver.aruba.hmac.key=kukka

•

where “kukka” is the key that you just typed in the Aruba Controller Web Interface

Save the file and close the text editor

• Re‐start Ekahau Positioning Engine service


Start > run > services.msc



Scroll to “Ekahau Positioning Engine Service” and double click



Click Start

Configuring Step 4: Activate Survey Tag and Perform Ekahau Site Survey
Ekahau Site Survey is a laptop‐based application for conducting a site survey and uploading a positioning
model to the EPE. See the appropriate Ekahau documentation for more details than are provided in this
document.
Figure 18

Ekahau Site Survey (ESS) Example
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A complete site survey of the facility is required for the Positioning Engine to track the tags. When high
location accuracy is desired, Ekahau recommends surveying the area with an Ekahau (T301a) tag.
Before surveying the area with a tag, the tag must be set to Survey Mode. This procedure is significantly
different for Aruba Blink Mode and Association Mode.
Prior to site surveys, you will need to add maps to ESS and set their scale.

24

[Aruba & Ekahau Design & Implementation Guide] | 01.22.09

Figure 19

ESS, Insert Map and Set Scale

Surveying with Aruba Blink Mode
Should there be any questions concerning Site Surveys, please consult the Ekahau Site Survey
documentation (Deploying RTLS with Ekahau Site Survey, included in the ESS installer). The following
includes the primary differences in performing an Aruba infrastructure‐based site survey rather than a
client‐based survey.
When performing site surveys using Aruba Blink Mode, you will need to:
• Activate the tag to connect to the Engine (EPE)
• Upload and update the tag firmware using Engine GUI (if necessary)
• Set the tag to Aruba Blink Survey Mode
• Connect to the Tag from Ekahau Site Survey (ESS)
• Perform Site Surveys
Tags need a WLAN that allows them to reach the EPE server in order to be configured and to have their
firmware updated. You may use the WLAN we have already defined, or you may use an alternate WLAN
for this purpose.
The steps in this section are only required when using Aruba Blink Mode. See the next section for Tag
Association Mode.
Activate Survey Tag to Connect to Engine (EPE)
Ekahau Activator is a program that runs on Wi‐Fi enabled Windows XP / 2000 / Vista laptop in order to
wirelessly assign basic settings to an Ekahau location tracking tag. Activator will let you configure the tag
with the EPE server’s IP address, and with the WLAN the tag should use to access the EPE server. For
more details, please see:
• T301 Activator User Guide
After successful activation, the tag will show up in the EPE GUI and the administrator will then be able to
fully manage the tags.
Figure 20

Ekahau Tag Activator, WLAN Settings
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Figure 21
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Ekahau Tag Activator, EPE Settings
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Figure 22

Ekahau Tag Activator, Scan Settings

Upload and Update Tag Firmware
A tag firmware update is typically only required if Aruba Blink Mode is used.
• Go to the EPE Web UI – see Ekahau documentation


Default setting is: http://<server‐IP>:8550



Default login is ‘admin / admin’



Note that default login can be changed under ‘users > admin’

• Check if the FW is 2.3.4 or newer. If not, proceed with firmware upload
• Upload new firmware to the EPE server


In the EPE UI, go to Configs > Upload new tag firmware



Browse to the new firmware (which needs to be on your management system hard drive)



Select tag FW 2.3.4 or newer
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Figure 23

EPE UI, Upload New Tag Firmware

• Install firmware on tags


Navigate to the Tags page



Select (via checkbox) the tags you want to update the Aruba FW to (in other words, the tags that
need to be located using Aruba Infrastructure‐based positioning)



After checking the tags, click Advanced



Select firmware version from Firmware Update, click Set



Wait until the maintenance interval is due for the tags, and wait until the tag FW is updated



Optionally click on the white tag button to force immediate FW update

Put One of the Tags in Aruba Blink Survey Mode
Users already familiar with Association Mode should note that one does NOT use Ekahau Activator for
setting the Survey mode. Instead, a manual command is pushed from the Engine to force the Aruba Blink
Survey Mode:
• After activating the tag and updating the FW, in the EPE GUI, go to Tags page, select the tag you want
to set to Survey Mode
• In the “manual commands” checkbox, type the following
wsc 1, 6, 11
I16:wsm 1
wcs 1 012345678901

Note: IMPORTANT: In this example, 1,6,11 are the channels used in the Aruba APs operating at
NOTE
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2.4GHz. Adjust if necessary. Use only the channels that the APs are on, nothing more, and
nothing less.
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NOTE

I16:wsm 1 sets the tag to Aruba Blink Mode. I16:wsm 0 sets the tag back to “traditional” ELP
Mode. The wcs 1 012345678901 command enables the survey mode (tag blinks rapidly (the
light does not, but the tag sends “blink packets” more frequently)

• Press “Send Commands”
• Push the white button on the tag to force the update or wait for the maintenance interval
Note: In FW version 2.3.4 the tag lights do not blink in Aruba Survey mode – you will need to
NOTE

check correct operation using ESS. There may be some other issues with the lights also (with
periodic scanning, for example).
Note: When surveying with Ekahau T301 tags, the SSID will not be detected.

NOTE

Surveying with Tag Association Mode
The steps in this chapter are only required when using Tag Association Mode. See the previous chapter
for Aruba Blink Mode.
Put one of the tags to (Tag Association) Survey Mode
Use Ekahau Activator to set the tag to Survey mode:
• Select the Survey Activation tab, and configure the appropriate settings


If the location SSID is non‐broadcasting, ensure you enter the location SSID correctly



You can also enter a secondary SSID if so desired

• Now the tag will constantly blink, meaning it is constantly scanning and is ready for survey use
• Push the blue button to pause the scanning, and push it again to continue
• Close Ekahau Activator Application
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Figure 24

Ekahau Tag Activator, Activate Tag in Tag Association Survey Mode

Start Ekahau Site Survey (ESS)
• Go do Device > Devices
• Select Connect T301
• If the tag is blinking, ESS should find the tag and start scanning with it
• Exit the Devices dialog
• Click on the miniature signal strength view
• You should see signal strength values updating, and data coming in from device T301 (if not, repeat
the procedure to re‐detect the tag)
• Perform site surveys as you normally would (for details, see Ekahau Site Survey User Guide)
• After performing the surveys, test real‐time tracking of the tag and/or perform additional test surveys
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Figure 25

ESS, Connecting a T301 Tag with Site Survey Associating Mode

Note: When surveying with Ekahau T301 tags, the SSID will not be detected.
NOTE

Performing Surveys and Selecting My Access Points
Performing site surveys is easy: Just select the survey tool and click your current location on the map as
you go. Note that the data is constantly collected, not just when you click on the map.
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Figure 26

ESS, Performing Site Surveys

ESS needs to know which access points are in your network, and which are not. Only the APs in your
network will be used in positioning. Select My APs using the AP list.
To help this procedure and to see a clearer network picture overall, you can place all the access points on
the map after the surveys. Use Site > Automatically Place Access Points to automatically place the APs on
the map. This placement may not be spot‐on, but it gives a good idea where the strongest access points
are. You can move the APs to their correct locations using the edit tool.
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Figure 27

ESS, Selecting ‘My APs’

Configuring Step 5: Draw Tracking Rails, Open Spaces and Zones
Drawing Tracking Rails
For accurate location tracking, EPE needs the most common paths that are taken by the user. For this,
Ekahau uses Tracking Rails. The tracking rails are drawn on the map, using ESS, before or after the
surveys.
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Figure 28

ESS, Drawing Tracking Rails (Orange and White Lines)

Drawing Open Spaces
Should there be no known pathways in some location (such as in lobby areas or cafeterias). Tracking
Rails should not be drawn in these locations. Instead, use Open Spaces to draw a rectangle or a free‐form
polygon to indicate the area where the exact paths of movement will not be known a priori.

Note: Rails should always connect to Open Spaces to indicate that there is a way for the

tracked device to travel to an Open Space.
NOTE

Note: The rails should cover the entire tracking area, just as with the surveys. Wherever you
NOTE
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have rails, you should have surveys also. Please use the Calibration Quality Visualization in ESS
to see if you have surveyed on all the rails.
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Figure 29

ESS, Drawing Open Spaces and Tracking Rails (And Connecting Them)

Drawing Zones
If you want to associate meaningful names to chosen areas of the facility (that are utilized in the end user
application), use Zones. For example, if the application needs to display whether the doctor is in the ER or
cafeteria, you will need to define those areas on the maps as ‘Zones’ – in this case, draw a Zone on the
map to cover the ER, and another to cover the cafeteria.
To draw Zones, use the Zone tool on the RTLS tab in ESS.
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Figure 30

ESS, Drawing Zones

Ensuring Location Tracking Accuracy (Precursor to Configuring Step 6)
Now that the Positioning Model is finished, it is recommended that one check the location tracking
accuracy. There are two main methods for doing this, Ekahau recommends implementing both methods
for optimum tracking accuracy:
• Live Accuracy Testing
• Accuracy Testing Using Test Surveys
Live Accuracy Testing
To test the accuracy right after the surveys, keep the Survey tag blinking, and keep the Ekahau Site
Survey open. On the RTLS Tab of ESS, click the Track button (the “target” icon in the upper‐right corner).
This allows your survey tag to be tracked by ESS. You can, in real‐time, see the location tracking accuracy
when walking around the facility.
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Figure 31

ESS, Testing Location Tracking Accuracy in Real-Time

Accuracy Testing Using Test Surveys
Ekahau also recommends performing quick test surveys around the facility. Perform a secondary set of
surveys similarly to the previous surveys. Covering about 10‐25% of the original survey area is a good
target.
Go to the Surveys tab (instead of Access Points list), and assign the surveys you just made as Test Surveys
only. You can highlight multiple surveys, right‐click, and select Deselect from Calibration and Select as Test.
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Figure 32

ESS, Assigning Test Surveys

Now you can analyze the location accuracy based on the test surveys in several ways:
• Accuracy statistics: Go to Positioning > Accuracy Statistics to display a summarized numerical analysis
of the floor, meter/feet and zone accuracy
Figure 33

ESS, Analyzing Test Survey Location Accuracy, Accuracy Statistics

• Location Accuracy Heatmap Visualization: Check visually, on a map, what your location accuracy looks
like. This will display within‐floor accuracy as well as any floor errors (floor errors marked with
circles or rectangles, green is high accuracy)
Figure 34 ESS, Analyzing Test Survey Location Accuracy, Location Accuracy Heatmap
Visualization
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• Error Vectors (View > Error Vectors): This will show you the actual location errors on the map, one‐
by‐one. The blue arrows will show where you were originally placed (the starting point of the arrow)
and where the EPE would have placed you (the end point of the arrow).
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Figure 35

ESS, Analyzing Test Survey Location Accuracy, Error Vectors

Should there be locations where location accuracy problems are repeatedly encountered, check the signal
coverage in those locations using Signal Strength and Location Coverage heatmap visualizations. If there
is insufficient coverage there, Ekahau suggests first performing more (calibration) surveys in the area,
and if the problem persists, adding more APs is recommended for consideration. Please see the image
below for basic accuracy improvement guidelines.
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Figure 36

Evaluating Location Accuracy: Accuracy Improvement Guidelines

Configuring Step 6: Upload Positioning Model from Ekahau Site Survey to Ekahau
Positioning Engine
Now that the Positioning Model has been completed and tested, it’s time to upload it to the Ekahau
Positioning Engine:
• Save the .esx Project on a USB drive
• Copy the .esx to the Engine computer
• Using the Engine GUI, upload the Model to Engine:


Go to Models > Upload a New Model



Activate the model after uploading it by clicking on the model name and selecting Set Active

Your Ekahau Positioning Engine is now ready to track Wi‐Fi devices.

Configuring Step 7: Deploy Tracking Tags
Your Tags, EPE and Aruba infrastructure have now been configured to use infrastructure‐based signal
measurements. You can now apply programming settings and change T301 tag configurations as
described in the Ekahau Positioning Engine User Guide
Production Tag Configurations for Aruba Blink Mode
• Use Ekahau Activator to connect all the production tags to the Engine (EPE)
• In the EPE GUI, select all the tags or tag groups you want to set the configuration to, and send the
configuration to the tags


Do remember to check the Aruba Blink Mode check box in the tag configuration page

For improving accuracy in Aruba blink mode, Ekahau recommends increasing the blink rate with the
multi‐scan command.
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Note: Push the production configurations to the tags immediately after activating the tags, as
NOTE

the default initial tag activation sets the tags to frequent wakeup interval, which may drain the
battery quickly.

Production Tag Configurations for Tag Association Mode
• Use Ekahau Activator to activate all the production tags to connect to Engine.
• Use the EPE Web GUI to configure the production settings to the tags.
• For improving accuracy in association mode, Ekahau recommends increasing the blink rate with the
following Advanced Scan settings:
•

Initial Scan 3

•

Aftermotion Scan Count 3 – 6 (depending on battery life expectations) in cases where
motion sensor is enabled.

•

Button Scan Count 3 if button is used in production.

Note: Push the production configurations to the tags immediately after activating the tags, as
NOTE

the default initial tag activation sets the tags to frequent wakeup interval, which may drain the
battery quickly

Tag Battery Life vs. Blink Rate
The more frequently the tags blink, the shorter the battery life will be. In asset tracking scenarios, a 30‐
minute wakeup interval, combined with motion or aftermotion tracking, may be acceptable (resulting in
years of battery life with T301a). Personnel tracking, however, may require 30 second wakeup (requiring
frequent recharge).
The EPE GUI includes a battery life calculator based on the current wakeup settings.
See ‘Activate Tags to Connect to Engine (EPE)’ section above for more details relating to tag configuration
and setup.

Special and Advanced Considerations
Multiple Simultaneous Surveyors
In a multi‐floor building, several surveyors can survey different floors of the building simultaneously. Use
File > Merge in ESS to combine the Projects after surveying.

Outdoor Deployments
When working in outdoor environments, special considerations may need to be taken. The accuracy may
not be as high as for indoor deployments depending on the method of coverage, AP density, etc.
The survey data in EPE is associated with the rails, and needs to be close enough to the rails. This may not
always be the case in large outdoor deployments. Go to Site > Set Active Map Type to adjust the map type
to Outdoor – this allows the survey data to be connected to the rails from a further distance. Use the
Calibration Quality Visualization to verify that the survey data has been associated with the rails.
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Figure 37

Calibration Quality Visualization and Rail Width

Please consult Ekahau Site Survey user documentation and Ekahau Engineering (support@ekahau.com)
for details on outdoor deployment best practices.

Improving Accuracy
If the accuracy is not satisfactory, first perform more surveys in the area. If the accuracy is still not
acceptable, access points may be added to the problematic areas.

Achieving Very High Room Accuracy
To achieve very high room accuracy, for example in process optimization applications, Ekahau
recommends using additional Location Beacons. The battery‐powered Location Beacons are mounted in
the rooms to provide additional accuracy in those rooms. In this case, Ekahau Positioning Engine uses
both Wi‐Fi APs and Location Beacons to calculate the tag locations.
Use the Location Beacon tool in ESS to place the location beacons on the map. Also, each area where
location beacon is placed needs a Zone.
Please consult Ekahau Site Survey user documentation and Ekahau Engineering (support@ekahau.com)
for details Location Beacons.
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Contacting Aruba Networks
Web Site Support
Main Site

http://www.arubanetworks.com

Support Site

http://www.arubanetworks.com/support

Software Licensing Site

https://licensing.arubanetworks.com

Wireless Security Incident Response Team (WSIRT)

http://www.arubanetworks.com/support/wsirt

Support Email

support@arubanetworks.com

WSIRT Email

wsirt@arubanetworks.com

Telephone Support
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Aruba Corporate

+1 (408) 227-4500

FAX

+1 (408) 227-4550

Support
• United States
• France
• United Kingdom
• Germany
• All Other Countries

800-WI-FI-LAN (800-943-4526)
+33 (0) 1 70 72 55 59
+44 (0) 20 7127 5989
+49 (0) 69 38 09 77 22 8
+1 (408) 754-1200
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